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Question: 1 
Your requirement is to allow only one industry for a given Account. What would you do to start to 
meet the requirement? 
 
A. Create a new Industry table. 
B. Create a new foreign key on S_INDUST that points to S_ORG_EXT. 
C. Validate there is a foreign key on S_ORG_EXT that points to the Industry business 

component's main table. 
D. Validate there is a foreign key to the Industry business component's main table on the 

S_ORG_INDUST table. 
E. Validate there is a foreign key on the Industry business component's main table that points to 

the S_ORG_EXT table. 
 
Answer: C 
 
Question: 2 
What are view Web template items? 
 
A. View object definitions 
B. Applets that have been bound to a view 
C. Controls that have been bound to an applet 
D. Siebel tags used to define the applet parameters in a view 
 
Answer: B 
 
Question: 3 
You need to check the main corporate address for the Service Request.  
 

 
 
Which column is the appropriate foreign key to use to access the data? 
 
A. CST_OU_ID 
B. OU_ADDR_ID 
C. OWNER_OU_ID 
D. PER_ADDR_ID 
 
Answer: B 
 
Question: 4 
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Which assignment deployment method would you most likely use to get a list of qualified 
candidates in order to select the best person for assignment? 
 
A. Batch assignment 
B. Dynamic assignment 
C. Interactive assignment 
D. Manual assignment 
 
Answer: C 
 
Question: 5 
Your team extended the Siebel database by creating a new stand-alone table. Select the two true 
statements. (Choose two.) 
 
A. This table does not contain a ROW_ID column. 
B. The user key for this table is ROW_ID, NAME, TYPE. 
C. The table cannot be added to an existing dock object. 
D. This table contains a PAR_ROW_ID column acting as a foreign key to the S_PARTY table. 
E. You can create an intersection table to support M:M relationships between business 

components based on this table and other business components. 
 
Answer: C, E 
 
Question: 6 
Which statement is true of Customer data? 
 
A. includes static, referential data 
B. has access controlled at the record level 
C. can be grouped into catalogs and categories 
D. is created and managed by only company administrators 
 
Answer: B 
 
Question: 7 
Which EIM Delete process option should you use to delete just the rows from an EIM table that 
contain a specific word? 
 
A. DELETE MATCHES 
B. DELETE EXACT 
C. DELETE ALL ROWS 
D. DELETE WHERE 
 
Answer: A 
 
Question: 8 
The hyperlinks in Siebel Tools do not appear. What might the problem be? 
 
A. The Web update protection key is invalid. 
B. The Drilldown Add-in has not been installed. 
C. You do not have the appropriate responsibility. 
D. Siebel Tools is not properly connected to the data source. 
 
Answer: C 
 
Question: 9 
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Which three products do you have the option of installing with the Siebel Enterprise Server 
Installer? (Choose three.) 
 
A. Siebel Tools 
B. Siebel Server 
C. Siebel Web Client 
D. Sample Database 
E. Gateway Name Server 
F. Siebel Web Server Extensions 
G. Database Configuration Utilities 
 
Answer: B, E, G 
 
Question: 10 
The No Delete property on the Contact business component is set to FALSE and the No Delete 
property on the Contact Form applet is set to TRUE. How does this affect the ability to delete a 
record through the client using the Contact Form applet? 
 
A. Users will be able to delete a record because the least restrictive setting is used. 
B. Users will not be able to delete a record because the most restrictive setting is used. 
C. Only the record owner will be able to delete a record because of the conflicting settings. 
D. Users will be able to delete a record because the business component setting overrides the 

applet setting. 
 
Answer: B 
 
Question: 11 
Which three does Siebel task UI support? (Choose three.) 
 
A. Undo 
B. Pause/Resume 
C. Sharing of tasks 
D. Transferring of tasks 
E. Branching within a task 
 
Answer: B, D, E 
 
Question: 12 
Which two are true regarding the Application Deployment Manager package descriptor file? 
(Choose two.) 
 
A. It is manually moved to the package directory. 
B. It is generated via the admpkgr generate command. 
C. It is automatically generated by the export processes. 
D. It is used by the deploy copy command to create the deployment session. 
E. It is used by the deploy load command to map contents to the Management Server database. 
 
Answer: B, E 
 
Question: 13 
Which three are true about the workflow process simulator in Siebel Tools? (Choose three.) 
 
A. Supports simulating interactive workflows 
B. Requires both Siebel Tools and a Siebel Client 
C. Requires the use of a local developer database 
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D. Supports editing of process properties during a simulation 
E. Supports simulating workflows that involve a server component 
F. Supports simulating workflows with a run-time event on a start step 
 
Answer: A, B, D 
 
Question: 14 
What does Enterprise Integration Manager use to prevent duplication of records during 
processing? 
 
A. Primary keys 
B. Foreign keys 
C. User keys 
D. Indexes 
 
Answer: C 
 
Question: 15 
You have created a new button on an applet that will launch a workflow. You want the workflow to 
process the current record. What do you do? 
 
A. Configure a Control User Property to pass [Id] to the workflow 
B. Configure an Applet User Property to pass [Id] to the workflow 
C. Add a Row ID process property to the workflow 
D. Set the Pass Row ID property of the button to True 
 
Answer: B 
 
Question: 16 
You have been asked to create a multi-value group for contacts phone numbers. What should 
your first step in this configuration be? 
 
A. Create a new business component to store these phone numbers. 
B. Determine which column on the base table you can use to store these phone numbers. 
C. Determine which column on the one-to-many extension table you can use to store these 

phone numbers. 
D. Run the MVG Wizard in Siebel Tools, specify the business component, and have it 

automatically select the appropriate column. 
E. Examine the existing application to determine whether there is already a multi-value group you 

could leverage to store phone numbers. 
 
Answer: E 
 
Question: 17 
Which Siebel business entity represents businesses external to your company that could be a 
current or potential client, business partner, or competitor? 
 
A. Contact 
B. Account 
C. Position 
D. Opportunity 
 
Answer: B 
 
Question: 18 
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You created a new form applet. During your testing, one of the controls does not display any 
data. Which two could cause this? (Choose two.) 
 
A. The control is not mapped to a web template item. 
B. The control is not mapped to a field on the business component. 
C. The Join property on the single value field that the control maps to is blank. 
D. There is no data in the database for the column to which the control maps. 
E. The RUNTIME value is set to FALSE on the picklist associated with the control. 
 
Answer: B, D 
 
Question: 19 
What is the primary difference between an organization and a division? 
 
A. Divisions can be deleted, organizations cannot. 
B. Organizations can be deleted, divisions cannot. 
C. Positions are assigned to organizations, and not divisions. 
D. Organizations are used for Access Control, divisions are not. 
 
Answer: D 
 
Question: 20 
You are creating a new view which contains a list applet at the top and a form applet at the 
bottom. Both applets are based on the same business component. For one set of users, all the 
data shown in both applets should be editable. For another set of users the form applet should 
not allow deletes or updates. 
What should you do? 
 
A. Create two views and set the No Update property to TRUE for one of them. 
B. Create two views and set Read Only View to TRUE when you add one to the responsibilities. 
C. Create two list applets and set the No Delete and No Update properties to TRUE for one of 

them. 
D. Create two form applets and set the No Delete and No Update properties to TRUE for one of 

them. 
E. Create two business components set the No Delete and No Update properties to TRUE for 

one of them. 
 
Answer: D 
 
Question: 21 
Why would you want to enable primaries for a multi-value group? 
 
A. It improves performance. 
B. Without a primary, only one record can be referenced. 
C. The multi-value group will not function without a primary. 
D. Primaries are necessary, as only they can modify the data. 
 
Answer: A 
 
Question: 22 
You have populated millions of products in your test system and you are ready to move them to 
your production system. Which would you use? 
 
A. Update Server 
B. Assignment Management 
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C. Enterprise Integration Manager (EIM) 
D. Application Deployment Manager (ADM) 
 
Answer: C 
 
Question: 23 
What Siebel feature limits the user's ability to change a picklist value from one value to another? 
 
A. Siebel Audit Trail 
B. Siebel Dynamic Picklists 
C. Siebel State Model 
D. Siebel Data Manager 
 
Answer: C 
 
Question: 24 
Why are implicit joins used for joining party data? 
 
A. Implicit joins are not used with party data. 
B. To bring party data into a non-party business component. 
C. To bring party data into another party business component. 
D. To map columns in party extension tables to party business components. 
 
Answer: D 
 
Question: 25 
You want to automatically delete all child activity records when a contact record is deleted. Which 
is the simplest way to configure this? 
 
A. Use a property on the Contact Activity Link 
B. Use a property on the Contact business component 
C. Use a Contact business component user property 
D. Use a workflow policy to monitor contact records 
E. Use a workflow triggered by a delete run-time event on the Contact business component 
 
Answer: A 
 
Question: 26 
Which two clients obtain initialization settings from both the configuration file and Application 
Object Manager component parameters? (Choose two.) 
 
A. Web Client 
B. Handheld Client 
C. Mobile Web Client 
D. Wireless Web Client 
E. Dedicated Web Client 
 
Answer: A, D 
 
Question: 27 
Which position on the team is authorized to merge and delete records and forecast opportunities? 
 
A. Any position on the team 
B. Leader 
C. Primary 
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D. Administrator 
 
Answer: C 
 
Question: 28 
You add a business component which has existing data to an existing business object. You forget 
to set the Link property. Which two are true? (Choose two.) 
 
A. No child records appear for any parent. 
B. All child records appear for each parent. 
C. The same set of child records appear for each parent. 
D. The view will not display the applet associated with the business component. 
 
Answer: B, C 
 
Question: 29 
You want to capture a new field for Contacts that is 101 characters long.  
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Which column should you map to? 
 
A. ATTRIB_44 
B. ATTRIB_45 
C. ATTRIB_46 
D. ATTRIB_47 
E. ATTRIB_48 
 
Answer: D 
 
Question: 30 
Joe is a contractor working for your company. You need to provide Joe access to the Siebel Call 
Center application, including several access-controlled views such as accounts and contacts. 
Which three actions must you take to grant Joe access to the application? (Choose three.) 
 
A. Assign a company to Joe. 
B. Assign a position to Joe. 
C. Assign a responsibility to Joe. 
D. Assign Joe to an access group. 
E. Install the application on his machine. 
F. Create Joe as an employee in the application. 
 
Answer: B, C, F 
 
Question: 31 
Which Server Administration feature can be configured to notify the Administrator when a server 
component reaches an undesired state? 
 
A. Audit trail 
B. System Alerts 
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C. Siebel State Model 
D. Component Event Logging 
 
Answer: B 
 
Question: 32 
You set the search specification on the Account business component to [Status] = Active and the 
search specification on the Account List Applet to [Status] = Red Customer What do you see 
when you navigate to the Account List View? 
 
A. Both Active and Red Customer accounts, because the search results are ORed together. 
B. Nothing, because the search results are ANDed together. 
C. Only Active accounts, because the search specification on the business component takes 

precedence. 
D. Only Red Customer accounts, because the search specification on the applet takes 

precedence. 
E. An error message, because the application detects the conflicting search specifications. 
 
Answer: B 
 
Question: 33 
View the Exhibits to inspect the picklist properties and your existing records.  
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You are using an existing pick list to help users enter values for the Status field on Service 
Requests. Your requirements have changed and now instead of displaying "Pending" in the list, 
you want to display "Waiting for Customer". You have a single language implementation. Which 
two are true? (Choose two.) 
 
 
A. Existing records with Pending values will display Pending when they are next displayed. 
B. You must create a new Pick List object definition. 
C. You must administer the list of values with type SR_STATUS and change the Pending Display 

Value to Waiting for Customer. 
D. Existing records will change from Pending to Waiting for Customer when they are next 

displayed. 
E. When you edit the Summary field on an existing record with status Pending, you will be forced 

to change the status. 
 
Answer: A, C 
 
Question: 34 
Which represents a business entity and groups data from one or more tables? 
 
A. Applet 
B. Application 
C. Business object 
D. Business component 
 
Answer: D 
 
Question: 35 
In Server Administration, you want to use the same set of parameters for several different 
components. How would you best accomplish this without manually setting the parameters for 
each and every component? 
 
A. Create a named subsystem (or profile). 
B. Copy the component to inherit the original parameter values. 
C. Right-click the Parameter Details list and select Propagate Parameters from the menu. 
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D. Select all of the parameters from one component, then copy and paste them into the other 
components. 

 
Answer: A 
 
Question: 36 
Your company maintains several different Marriott accounts such as Marriott, Marriott Europe, 
and Marriott Asia, with all such accounts starting with the word "Marriott". You wish to get a list of 
all of your contacts associated with any of the Marriott accounts. You navigate to the contacts list 
view. Which query do you perform on the Accounts MVG? 
 
A. EXISTS "Marriott " 
B. EXISTS (Marriott) 
C. EXISTS ("Marriott") 
D. IS IN "Marriott" 
E. IS IN (Marriott) 
F. IS IN ("Marriott") 
 
Answer: B 
 
Question: 37 
You are working with a team of developers who are customizing the Siebel Sales application. You 
were doing some preliminary prototyping in the Opportunity project. Because you did not expect 
to check any of this work in to the server, you released the lock on the server and maintained the 
lock on the local repository. 
You now realize that you do indeed want to check your work in to the server. Which procedure 
should you follow to get your work into the server repository without disrupting the other 
developers' work? 
 
A. Copy your local Siebel repository file to the server. 
B. Archive your work into a .sif file and then import that .sif file into the server repository. 
C. Check out the Opportunity project again, and then check the project back in. 
D. Archive your work into a .sif file, check the project out, import the sif file into the local 

repository, and then check the project back in. 
 
Answer: D 
 
Question: 38 
You want to expose the budget amount as a field on the Opportunity business component and 
insure that the amount entered is not negative. 
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Which three property/values would you configure on the SVF? (Choose three.) 
 
A. Validation set to >= 0 
B. Post Default Value set to >= 0 
C. Type set to DTYPE_CURRENCY 
D. Type set to DTYPE_NUMBER 
E. Column set to BDGT_AMT 
F. Text Length set to 22 
 
Answer: A, C, E 
 
Question: 39 
For which two can you define scores in order to use scoring with Assignment Manager? (Choose 
two.) 
 
A. Criteria 
B. Rule group 
C. Candidate 
D. Mode 
 
Answer: A, C 
 
Question: 40 
You are adding a single value field to the Opportunity business component to show the 
ATTRIB_38 column from the S_OPTY_X table. Which is true about the Join/Join Specification? 
 
A. There is no explicit Join or Join Specification. 
B. Destination Column = ROW_ID and Source Field = Id 
C. Destination Column = PAR_ROW_ID and Source Field = Id 
D. Destination Column = ROW_ID and Source Field = Opportunity Id 
E. Destination Column = PAR_ROW_ID and Source Field = Opportunity Id 
 
Answer: A 
 
Question: 41 
What does the Component Reconfiguration feature allow you to do? 
 
A. Modify component parameters while allowing existing component tasks to continue running 

using the old parameters. 
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B. Activate reconfigured components at the next server restart. 
C. Move server components from one server to another. 
D. Stop all current instances of a component and restart them with new parameters. 
 
Answer: A 
 
Question: 42 
You are adding a Join and Join Specification to the Service Request business component to 
access data in the S_ASSET table. You set the Outer Join Flag to FALSE, the Destination 
Column to ROW_ID and the Source Field to Id. What will the result be? 
 
A. No rows will be returned. 
B. You will get an SQL error. 
C. The implicit join will override this join. 
D. All rows in the S_SRV_REQ will be returned. 
E. All rows in the S_ASSET table will be returned. 
 
Answer: A 
 
Question: 43 
You are running the Call Center application and have changed the directory of the sample 
database. You need to update which file to reflect it? 
 
A. siebel.srf 
B. .swt file 
C. eapps.cfg 
D. uagent.cfg 
E. file system file 
 
Answer: D 
 
Question: 44 
You want to alert a manager if a service request has not been assigned after two hours. Which 
two items should you create? (Choose two.) 
 
A. A Siebel task 
B. An iHelp item 
C. A workflow policy 
D. Siebel Activity Plan 
E. An assignment manager rule 
F. A workflow process to notify the manager 
 
Answer: C, F 
 
Question: 45 
A few users want to see the Contacts screen tab to the left of the Accounts screen tab in the Call 
Center application when they log in. Which action could you take to satisfy the requirement? 
 
A. Create a new position and assign the set of users to it. 
B. Blank out the sequence number for the Accounts Screen in the application object definition in 

Siebel Tools. 
C. Show the users how they can change the Screen Tab Layout in User Preferences when they 

log in to the Call Center application. 
D. Change the configuration in Siebel Tools so that the Contacts Screen Override property is set 

to TRUE. 
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Answer: C 
 
Question: 46 
Which three are true regarding object definitions? (Choose three.) 
 
A. They cannot be exported. 
B. They are created from an object type. 
C. They are compiled into the file system. 
D. They are displayed in the object explorer. 
E. They are displayed in the object list editor. 
F. They are defined by assigning values to properties. 
G. They are edited using the client application or Siebel Tools. 
 
Answer: B, E, F 
 
Question: 47 
Your business model requires that you change the Job Title for contacts to be a required field. 
Select the true statement. 
 
A. You cannot copy records whose Job Title is NULL. 
B. You must modify the JOB_TITLE column of the S_CONTACT table to make it non-nullable. 
C. Existing contacts whose Job Title is NULL will be visible only in the contacts administration 

screen. 
D. You specify the Job Title field as required by setting the Required flag to TRUE in the 

appropriate applet(s). 
E. You specify the Job Title field as required by setting the Required flag to TRUE in the 

appropriate business component. 
 
Answer: E 
 
Question: 48 
When should you use explicit primaries through Enterprise Integration Manager? 
 
A. When there is only one child record in the dataset 
B. Any time you have more than one child record in the dataset 
C. When the external system defines which child record should be the primary 
D. When the external system does not define which child record should be the primary 
 
Answer: C 
 
Question: 49 
What must you do in order to ensure that the Workflow simulator opens the Mobile Web Client 
and accesses the correct database when a simulation is initiated? 
 
A. Select Debug from the View > Options menu and enter the local client start-up information. 
B. Right-click the design canvas and select Simulate, then enter the local client start-up 

information. 
C. Select Simulator Options from the View > Options menu and enter the local client start-up 

information. 
D. Right-click the design canvas and select Simulate Options, then enter the local client start-up 

information. 
 
Answer: A 
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Question: 50 
Which three of the following must you configure in order to create a task? (Choose three.) 
 
A. Task flow 
B. Task view 
C. Task applet 
D. Task screen 
E. Task chapters 
F. Task group item 
 
Answer: A, B, F 
 
Question: 51 
You have two accounts: 
- NY Express in New York state with industry classification Finance 
- CA Bank in California state with industry classification Finance. 
You have an assignment rule that assigns accounts based on state and another that assigns 
them based on industry. 
Your requirement is that Finance industry accounts should be handled exclusively by the Finance 
team. 
Which must you do to configure the rules to support this? 
 
A. Create separate rule groups for each rule. 
B. Add scores to evaluate the skills of the employees. 
C. Add the rules to a rule group and assign the finance rule a lower sequence number. 
D. Add the rules to a rule group and assign the finance rule to a higher sequence number. 
E. Set the rules to be exclusive. 
 
Answer: C 
 
Question: 52 
What is true when a user does not have access to any views in a screen? 
 
A. The views are listed only on the Site Map. 
B. The Screen containing the views is available on the Site Map, but it is empty. 
C. The views are only accessible through a drilldown. 
D. The screen is not available in the application, either through a screen tab or the Site Map. 
 
Answer: D 
 
Question: 53 
You need to search Service Requests in your workflow. You add a Siebel Operation step. Which 
two are true? (Choose two.) 
 
A. You set the Operation property to Query. 
B. You set the Operation property to Search. 
C. You set the Operation Property to Update. 
D. You set the Business Object property to Service Request. 
E. You set the Business Component property to Service Request. 
 
Answer: A, E 
 
Question: 54 
Which three steps can be performed during administration of a newly-deployed rule module? 
(Choose three.) 
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A. Activate the rule module 
B. Assign a business object 
C. Set an expiry date for the rule 
D. Set the Data Assertion Mode to runtime 
E. Synchronize the rule with the repository 
F. Select one or more rule module relations 
 
Answer: A, B, F 
 
Question: 55 
You are working in the high-interactivity Web client. You start creating a new record in the 
Contact list applet. When is the record committed to the database? (Choose two.) 
 
A. You select Save Record from the applet-level menu. 
B. You enter data into a field and then select a different field. 
C. You enter data into the record and then select a different record. 
D. You click on the form applet to enter data into a field that is not available in the list applet. 
 
Answer: A, C 
 
Question: 56 
Which two statements are true about using the Table wizard to create a new intersection table 
between two non-party tables? (Choose two.) 
 
A. The parent tables must have a type set to Data (Intersection) 
B. The new table will have type setting of Data (Intersection) 
C. The new table will include two foreign key columns 
D. The new table will include a PAR_ROW_ID column 
 
Answer: B, C 
 
Question: 57 
You want to add a business service step to a workflow. Which three are steps that you might 
perform to configure the business service step? (Choose three.) 
 
A. Create additional process properties 
B. Assign a value to the Business Service Name property 
C. Assign a default value to the Object Id process property 
D. Assign a value to the Business Service Method property 
E. Create input arguments by right-clicking the business service step and selecting Show Input 

Arguments 
F. Create one or more output argument records for the business service and set the type to 

Business Service 
 
Answer: A, B, D 
 
Question: 58 
Which three are reasons why you would consider implementing a business policy using Siebel 
Business Rules? (Choose three.) 
 
A. Business rules can be centrally developed and administered. 
B. Business rules do not require compilation of the repository file. 
C. Business rules are modeled using a precise graphical modeling language. 
D. Business rules typically execute faster than repository-based configuration. 
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E. Business rules can be easily updated to implement rapidly changing business policies. 
 
Answer: A, B, E 
 
Question: 59 
Which two are true of the Siebel File System? (Choose two.) 
 
A. Must be named siebfile 
B. Must be a single file system on a single drive 
C. Must support long and case-sensitive filenames 
D. Must be accessible from machines running Siebel Servers 
 
Answer: C, D 
 
Question: 60 
You created a new view in Siebel Tools, one group of users (Group A) can see it in the 
application, but another group of users (Group B) cannot see it in the application. What would 
cause this? 
 
A. You forgot to add the view to a screen. 
B. You gave the wrong view name to the administrator. 
C. The administrator forgot to activate the responsibility. 
D. The administrator assigned the view to a responsibility that none of the users in Group B 

possess. 
E. The administrator set the Read Only View flag to TRUE when adding the view to the 

responsibility. 
 
Answer: D 
 
Question: 61 
Which authentication method allows for self-registration by Web users? 
 
A. Web Single Sign On 
B. database authentication 
C. Windows authentication 
D. Directory Server authentication 
 
Answer: D 
 
Question: 62 
You are creating a new child business component to support displaying promotional items that 
have been sent to Contacts. What type of table do you base the new business component on? 
 
A. The base table of the parent business component. 
B. Standard interface tables supplied by Siebel. 
C. Standard 1:M extension tables supplied by Siebel. 
D. New tables that you create with the Business Component wizard. 
 
Answer: C 
 
Question: 63 
You wish to prototype some of your ideas on the Activities project. You currently have the project 
checked out. You wish to check in the changes you're made so far and release the lock on the 
server, but then you want to continue development locally. What do you do? 
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A. Undo the check out and continue working locally. 
B. Perform a Get on the project, lock it, and continue working locally. 
C. Save your current changes as a .sif file and continue working locally. 
D. Cancel the check out, lock the project locally, and continue working locally. 
E. Check in the project while maintaining the lock, undo the check out, and continue working 

locally. 
 
Answer: E 
 
Question: 64 
You wish to configure a task flow that allows a user to create an account and add one or more 
contacts. Which three steps must appear in the task flow? (Choose three.) 
 
A. A task view step that is bound to a summary view. 
B. A Siebel operation step to create a new account record. 
C. A task view step that displays a view containing, at minimum, a task applet. 
D. A Siebel operation step to create a transient business component. 
E. A decision step that controls flow to a Siebel operation step to create a new contact. 
F. A commit step to save each contact record entered before the user enters a new one. 
 
Answer: B, C, E 
 
Question: 65 
You created a new view in Siebel Tools, but none of the users can see it in the application. Which 
three could cause this? (Choose three.) 
 
A. You forgot to add the view to a screen. 
B. You gave the wrong view name to the administrator. 
C. The administrator forgot to activate the responsibility. 
D. The administrator assigned the view to a responsibility none of the users possess. 
E. You left the Category Name blank when you created the Screen View object definition. 
F. The Default Local Access flag was set to TRUE by the administrator when adding the view. 
 
Answer: A, B, D 
 
Question: 66 
Which three are true of the Web Layout Editor? (Choose three.) 
 
A. It is used to lay out form applets. 
B. It can be used to add and remove applet Web template items. 
C. It is invoked automatically upon completion of the List Applet wizard. 
D. Items not on the template can be imported using the Web layout editor. 
 
Answer: A, B, C 
 
Question: 67 
How do you specify the type of owners that records in a business component may have? 
 
A. Add the business component to the appropriate Access Group. 
B. Add the business component to the appropriate responsibilities. 
C. Set the Owner property in the business component's Properties window. 
D. Add the necessary owner types to the Business Component View Modes list for the business 

component. 
 
Answer: D 
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Question: 68 
What is displayed in the Thread Bar if the Thread Title property is null in the thread properties? 
 
A. A hyperlink is not added to the thread bar. 
B. A question mark is displayed in the thread bar. 
C. The Title property is used to populate the thread bar. 
D. The name of the business component is used to populate the thread bar. 
 
Answer: C 
 
Question: 69 
Which statement is true of Master data? 
 
A. Includes dynamic, transactional data 
B. Cannot be grouped into catalogs and categories 
C. Is created and managed by end-users of the application 
D. Access is controlled at the level of catalog and category 
 
Answer: D 
 
Question: 70 
You decided to use the S_CONTACT_XM table to store additional contact data. Which five new 
object definitions will you need to create to display this data as child data in a Detail View format? 
(Choose five.) 
 
A. link 
B. view 
C. MVG 
D. applet 
E. MVG applet 
F. business object 
G. business component 
H. business object component 
 
Answer: A, B, D, G, H 
 
Question: 71 
Which describes the role of Assignment Candidates for Assignment Manager? 
 
A. To identify the possible candidates that can be assigned to records 
B. To describe when a record should be assigned to candidates 
C. To identify the types of data to assign using Assignment Manager 
D. To evaluate all people for a matching skill in order to assign records 
 
Answer: A 
 
Question: 72 
When is it acceptable to run SQL against Siebel database tables? 
 
A. never 
B. to insert data into Siebel EIM (interface) tables such as EIM_ACCOUNT 
C. to drop tables from the database 
D. to insert data into Siebel customer (data) tables such as S_ORG_EXT 
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Answer: B 
 
Question: 73 
Which three are true about Siebel Servers? (Choose three.) 
 
A. Are J2EE application servers 
B. May run the Call Center object manager 
C. May run the Siebel Web Server Extension 
D. May run the Enterprise Integration manager 
E. Can only be installed on one machine in the enterprise 
F. May be installed on several machines in the enterprise 
 
Answer: B, D, F 
 
Question: 74 
Which two statements about static picklists based on the PickList Generic business component 
are true? (Choose two.) 
 
A. Values are displayed from the S_LST_OF_VAL table. 
B. They can be bounded or unbounded. 
C. They usually display values in a pick applet for selection. 
D. Values displayed in the picklists change during run time based on changes end-users make to 

data. 
 
Answer: A, B 
 
Question: 75 
What is the purpose of the SSA Primary field in a MVG applet? 
 
A. It allows users to select more than one primary. 
B. It indicates which child record cannot be deleted. 
C. It permits users to see and change the primary child record. 
D. It allows users to change which field is referenced in the child business component. 
 
Answer: C 
 
Question: 76 
You have changed an applet and its corresponding web template file. Which three actions must 
you perform on the source environment for deployment to the test environment? (Choose three.) 
 
A. Create a pre-defined query. 
B. Create a deployment session. 
C. Use the Siebel client to create an export file. 
D. Use Siebel Tools to export the object definition. 
E. Move the descriptor file and object definition to the package sub-directory. 
F. Move the updated .swt to a package sub-directory. 
 
Answer: D, E, F 
 
Question: 77 
Exhibit: 
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Which two fields are on the base table? (Choose two.) 
 
A. City 
B. CSN 
C. Closed Date 
D. Commit Time 
E. Contact Account 
F. Calculated Account 
 
Answer: C, D 
 
Question: 78 
You created workflow policies, but no records are being added to the S_ESCL_REQ table. Which 
two might explain the behavior? (Choose two.) 
 
A. No records violate the policy. 
B. The duration has been exceeded. 
C. You ran Generate Triggers with Exec=False. 
D. You failed to compile the Workflow Policy object. 
E. You did not activate the workflow process specified for the policy action. 
 
Answer: A, C 
 
Question: 79 
Which two are true regarding object types? (Choose two.) 
 
A. They have properties. 
B. They have properties and values. 
C. They are edited using Siebel Tools. 
D. They are templates for writing SQL. 
E. They are displayed in the object explorer. 
F. They are displayed in the object list editor. 
G. They are compiled into the Siebel repository file. 
 
Answer: A, E 
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Question: 80 
Which Assignment Mode filters all qualified organizations and persons and then assigns only 
those that have corresponding persons and organizations that meet the criteria? 
 
A. Independent 
B. Organization-oriented 
C. Person-oriented 
D. Org & person-oriented 
 
Answer: D 
 
Question: 81 
Which four statements apply to a transient business component? (Choose four.) 
 
A. It can only contain single value fields. 
B. Its data disappears once the task is paused. 
C. Its data disappears once the task completes. 
D. It stores one or more records in its base table. 
E. Its data disappears once the task is cancelled. 
F. It collects only data that is used to control task flow. 
G. It requires a task applet to collect and display the data for a transient business component. 
 
Answer: A, C, E, G 
 
Question: 82 
You wish to create a M:M relationship between contacts and colleges attended, to be displayed in 
both a Contacts-Colleges view and in a Colleges-Contacts view. You decide to implement this by 
first creating a stand-alone CX_COLLEGE table. What will you also need to create? (Choose all 
that apply.) 
 
A. A Contact/College link. 
B. A College/Contact link. 
C. A College business object. 
D. A College business component. 
E. A join between S_CONTACT and CX_COLLEGE. 
F. An intersection table between S_CONTACT and CX_COLLEGE. 
 
Answer: A, B, C, D, F 
 
Question: 83 
Instead of displaying Account list views separately, you wish to group them together under a 
heading called Accounts List.  
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Which property would you set, and to which value in the Screen View object definitions? 
 
A. Type to Detail Category 
B. Menu Text to Accounts List 
C. Viewbar Text to Accounts List 
D. Parent Category to Accounts List 
E. Sequence to the same number (for example 2 for all the views in the grouping) 
 
Answer: D 
 
Question: 84 
Which two statements are true regarding child access groups? (Choose two.) 
 
A. Child access groups can contain only user lists. 
B. Child access groups inherit access rights from parent access groups. 
C. A child access group may be assigned to multiple parent access groups. 
D. Child access groups can have more access rights than their parent groups. 
 
Answer: B, D 
 
Question: 85 
Which assignment deployment method would you most likely use to assign an opportunity to the 
appropriate sales representative based on territory whenever a new opportunity is created? 
 
A. Batch assignment 
B. Dynamic assignment 
C. Interactive assignment 
D. Manual assignment 
 
Answer: B 
 
Question: 86 
The VP of Sales has assigned some Account records to representatives and wants to maintain 
these assignees on the account teams. You are creating assignment rules to automatically assign 
Accounts. Which two actions would satisfy the requirement? (Choose two.) 
 
A. Compile a new .srf. 
B. Set Keep Creator to TRUE on the Account Assignment Object. 
C. Set Default Employee to SADMIN on the Account Assignment Object. 
D. Set Keep Manual assigned to TRUE on the Account Assignment Object. 
E. Set Ignore Assignment Attributes to TRUE on the Account Assignment Object. 
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F. Write assignment rules that recreate the criteria the VP used to manually assign the records. 
 
Answer: D, F 
 
Question: 87 
Which four are correct regarding repository workflow processes? (Choose four.) 
 
A. Can be created using Siebel Tools 
B. Can be activated using Siebel Tools 
C. Can be simulated using Siebel Tools 
D. Can be exported to XML files in Siebel Tools 
E. Can be exported to XML files in the Siebel Client 
F. Can be published using the Siebel Client 
 
Answer: A, B, C, D 
 
Question: 88 
In Server Administration, what does the Delete Parameter Override feature allow you to do? 
 
A. Delete the inherited parameter and input a new parameter. 
B. Use the current parameter on all levels higher than the current level. 
C. Remove the current parameter and reinstate parameter inheritance. 
D. Override the current parameter for the next single instance of the component. 
 
Answer: C 
 
Question: 89 
Which describes database authentication? 
 
A. It is the default authentication method for Siebel applications. 
B. It typically uses a single reserved database login for all users. 
C. It requires additional infrastructure components, such as security adapters. 
D. User authentication is performed by a third-party service at the Web server level. 
 
Answer: A 
 
Question: 90 
You decided to create an additional field to be displayed in an applet by adding a column to the 
business component's base table. In which order is it recommended practice to perform the 
required modifications? 
 
A. Table, Business Component, Applet 
B. Business Component, Table, Applet 
C. Table, Applet, Business Component 
D. Business Component, Applet, Table 
E. Applet, Business Component, Table 
F. Applet, Table, Business Component 
 
Answer: A 
 
Question: 91 
John has been added as a non-employee user of the application. Which two statements are true 
about non-employee users of the application? (Choose two.) 
 
A. A user must have at least one position. 
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B. A user must have at least one responsibility. 
C. A user must be assigned to at least one division. 
D. A user must be assigned to at least one organization. 
E. A user must be assigned to at least one access group. 
F. A user must be authenticated; for example, by having credentials such as a username and 

password. 
 
Answer: B, F 
 
Question: 92 
You wish to invoke a rule module (that you created using HaleyAuthority and administered in the 
Siebel client) using a run-time event and an action set. Which three must you specify when you 
configure the action in the action set? (Choose three.) 
 
A. An object type 
B. A business object 
C. A sequence number 
D. A business component 
E. The name of the rule module 
F. A business service and a method 
 
Answer: C, E, F 
 
Question: 93 
You created new users and added them to existing and new user lists. In the enterprise profile 
file, StopOnError = TRUE. When you attempt to deploy (using Application Deployment Manager) 
you are getting errors. Which could be a possible cause? 
 
A. You forgot to run a backup command. 
B. You forgot to generate a mid-level release in Siebel Tools. 
C. You sequenced User List before Users in the deployment. 
D. You sequenced Users before User List in the deployment. 
 
Answer: C 
 
Question: 94 
While testing some configuration changes to the Opportunity List Applet, you find that you are 
able to edit existing opportunities, but you cannot create new opportunities. Further testing 
reveals that you can create new opportunities in the Opportunity Form Applet - Child in the same 
view. 
What is this condition caused by? 
 
A. No Insert = TRUE and No Update = FALSE on the Opportunity business component. 
B. No Insert = TRUE and No Update = FALSE on one of the fields of the Opportunity business 

component which is displayed in the list applet but not in the form applet. 
C. No Insert = TRUE and No Update = FALSE on the Opportunity List Applet. 
D. No Insert = TRUE and No Update = FALSE on one of the list columns of the Opportunity List 

Applet. 
E. You failed to compile the Opportunity List Applet, hence it is still checked out and cannot 

accept new data. 
F. Your responsibility is not correctly configured; you do not have permission to see the New 

Opportunity view. 
 
Answer: C 
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Question: 95 
Which three are true about Siebel Business Rules? (Choose three.) 
 
A. They are stored in a knowledge base. 
B. They are created using the HaleyAuthority application. 
C. They are executed in the Business Rules Service server component. 
D. They are executed by invoking the Business Rules Service business service. 
E. They are automatically updated whenever the object definitions in the Siebel repository are 

changed. 
 
Answer: A, B, D 
 
Question: 96 
What is the base table for the Contact business component? 
 
A. S_CONTACT 
B. S_USER 
C. S_EMP_PER 
D. S_PARTY 
 
Answer: D 
 
Question: 97 
You are importing products and product lines. Your source data includes product names, product 
descriptions, and associated product lines, but does not include many of the required flags for the 
EIM_PROD_INT and EIM_PROD_LN tables. Most of these flags can be set to default values. 
Recommended practice is to add default values for these required flags _____. 
 
A. To the .ifb file 
B. In your source data 
C. Using the application administrative screens once the import is complete 
D. To the EIM_PROD_INT and EIM_PROD_LN tables after loading the source data into them 
E. To the EIM_PROD_INT and EIM_PROD_LN tables before loading the source data into them 
 
Answer: A 
 
Question: 98 
Which component of the Siebel architecture contains virtual directories? 
 
A. Siebel Servers 
B. Siebel Web Client 
C. Siebel Web Server 
D. Siebel Gateway Name Server 
 
Answer: C 
 
Question: 99 
You are cleaning up account data in the system. You know that your company maintains several 
different Marriott accounts such as Marriott, Marriott Europe, and Marriott Asia. All such accounts 
should start with the word Marriott, Unfortunately, users have used these different spellings for 
the accounts: Marriott Marriot Mariott and Mariot. 
Which query would you enter to query for all such accounts? 
 
A. Mar?iot? 
B. Mar?iot?* 
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C. Mar*iot* 
D. IS LIKE (Mar?iot?) 
E. IS LIKE (Mar*iot*) 
 
Answer: C 
 
Question: 100 
Which three are valid candidates for assignment through assignment rules? (Choose three.) 
 
A. Positions 
B. Responsibilities 
C. Persons 
D. Organizations 
E. Accounts 
 
Answer: A, C, D 
 
Question: 101 
On the Opportunity business component:  
 

 
 
What should the Join Specification look like when you are joining to the S_ORG_EXT table to 
access account information such as NAME? 
 
A. There is no explicit Join or Join Specification. 
B. Destination Column = PAR_ROW_ID and Source Field = Id 
C. Destination Column = ROW_ID and Source Field = Id 
D. Destination Column = NAME and Source Field = Account Name 
E. Destination Column = PAR_ROW_ID and Source Field = Account Id 
 
Answer: E 
 
Question: 102 
How should required columns be handled during EIM data mapping when you do not have any 
legacy data that maps to the required columns? 
 
A. Values must be provided for these columns. 
B. Required columns that are left blank will automatically be assigned a value of system 
C. These columns must be changed from enquired to optional before running the EIM process 
D. Required columns can be left blank during EIM and will be updated with default values when 

the records are updated through the user interface. 
 
Answer: A 
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Question: 103 
Which two statements concerning requirements for enabling state models on a business 
component are true? (Choose two.) 
 
A. The field used must be a single-valued field. 
B. The field used cannot contain more than twelve states. 
C. The field used should have no dependencies on other fields. 
D. The field used should not be named in any Workflow processes. 
 
Answer: A, C 
 
Question: 104 
You have reached a critical point in your development, and you wish to back up the objects you 
have configured so far. Which is NOT a valid method for backing up your object definitions? 
 
A. Copy the local .srf file. 
B. Copy the local .dbf file. 
C. Check in projects into the server. 
D. Use archive files to back up repository data. 
 
Answer: A 
 
Question: 105 
You have configured, verified, and published a task flow using Siebel Tools. You have registered 
the task flow in the Siebel client. However a link to the task does not display in the task pane. 
Which two items could cause this? (Choose two.) 
 
A. You did not activate the task. 
B. You did not clear the task cache. 
C. You did not add the task to a responsibility. 
D. You did not assign the task to a task group. 
E. You did not compile the views and applets in the task. 
 
Answer: C, D 
 
Question: 106 
Which defines a dynamic drilldown? 
 
A. Clicking an account record navigates you to sales team details. 
B. Clicking a contact name hyperlink always navigates to the contact detail. 
C. Clicking an account name navigates you to the last field of the current record in the current list. 
D. Clicking a contact name hyperlink navigates to contact details for US contacts and account 

details for non-US contacts. 
 
Answer: D 
 
Question: 107 
How can you verify the High Interactivity client environment after installation? 
 
A. Run Health Check. 
B. Run Environment Verification Test. 
C. Examine the Siebel Web Client registry file. 
D. Rerun the Installation Program and select Verify. 
 
Answer: A 
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Question: 108 
Where is the main data for organization-related business components stored? 
 
A. S_PARTY table 
B. S_ACCOUNT table 
C. S_ORG_EXT table 
D. S_ORG table 
 
Answer: C 
 
Question: 109 
CHENG has a Call Center agent position and has no one reporting to him. You have given him a 
responsibility that includes the "Manager's Account List View" (My Team's Account filter). What 
will be the outcome? 
 
A. You will get an error because you cannot assign a manager view to someone who does not 

have a manager position. 
B. The view will not display to him since he doesn't have a manager position. 
C. He will see the view, but he will not see any records. 
D. He will see the view, but he will only see records for which he is the primary on the Account 

Team. 
 
Answer: D 
 
Question: 110 
Which two statements are true about adding a custom extension column to an existing table? 
(Choose two.) 
 
A. You cannot add extension columns to interface tables. 
B. The new column name is automatically suffixed with _X. 
C. The new column name is automatically prefixed with X_. 
D. You must check out or lock the appropriate project/object definition before adding a column. 
 
Answer: C, D 
 
Question: 111 
You are creating a new view in Siebel Tools. When you attempt to add applets, you do not see 
the applet you want to add listed in the Available Applets list. Which two would cause this? 
(Choose two.) 
 
A. You failed to assign a Project. 
B. You picked the wrong Web Template. 
C. You selected the wrong Business Object for the view. 
D. The applet object definition has Inactive set to FALSE. 
E. The Business Component that the applet is based on is not part of the Business Object the 

view is based on. 
 
Answer: C, E 
 
Question: 112 
Which two are best practices regarding a developer who will be configuring the Siebel 
application? (Choose two.) 
 
A. Developers should be registered as a mobile client. 
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B. Developers should be database owners of the Siebel database. 
C. Developers must be added as an employee in the application. 
D. Developers must be assigned the Administrator responsibility. 
 
Answer: A, C 
 
Question: 113 
Which is the Primary Key for the S_CONTACT table? 
 
A. PAR_ROW_ID 
B. BU_ID 
C. EMP_ID 
D. ROW_ID 
 
Answer: D 
 
Question: 114 
In which three ways can a Siebel task be invoked? (Choose three.) 
 
A. By scheduling an activity 
B. By a long-running workflow 
C. By clicking a link in the task pane 
D. By clicking an entry in the user's inbox 
E. By navigating to the Tasks screen in the site map 
F. By right-clicking on a view and selecting Invoke Task 
 
Answer: B, C, D 
 
Question: 115 
Which object definitions in the Business Layer do List columns and controls in the UI Layer 
reference? 
 
A. Fields 
B. Columns 
C. Business objects 
D. Business components 
 
Answer: A 
 
Question: 116 
In Siebel Tools, you select Tools > Check Out and then select the Account project. You note that 
the Check Out button is inactive (greyed out). Choose two reasons this might occur. (Choose 
two.) 
 
A. You have already checked out the project. 
B. Another developer has already checked out the project. 
C. Allows Object Locking is set to TRUE for this project. 
D. You have not yet performed a Get on this project. 
E. A Developer Web Client is running and connected to your local database. 
F. A Developer Web Client is running and connected to your server database. 
 
Answer: B, C 
 
Question: 117 
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You modified the Contact List Applet, but you do not see the new list column when you log in to 
the Developer Web Client. Which two may cause this? (Choose two.) 
 
A. You modified the 1:Base mode. 
B. You modified the 1:EditList mode. 
C. You compiled All Locked Projects from Tools into the client .srf file. 
D. You set the HighInteractivity parameter to TRUE in the client uagent.cfg. 
E. You forgot to compile All Locked Projects from Tools into the server .srf. file. 
F. You previously used Columns Displayed to save a set of columns for the applet that did not 

include that column. 
 
Answer: A, F 
 
Question: 118 
Where can a run-time event be specified in a Workflow process? 
 
A. In the Start step properties 
B. On the branch following the start step 
C. In the Siebel Operation step properties 
D. On the branch following a Siebel Operation step 
 
Answer: B 
 
Question: 119 
You need to edit your company structure in the Siebel application. Which two are you able to do? 
(Choose two.) 
 
A. Delete a division 
B. Remove an organization 
C. Change a division's organization 
D. Change the name of an organization 
 
Answer: C, D 
 
Question: 120 
Where would you find Siebel specific tags that begin with swe: 
 
A. In cascading style sheets 
B. In Siebel configuration files 
C. In Siebel Web template files 
D. In Siebel Web Server Extension files 
 
Answer: C 
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